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nVision Reports – Fluid All Sites 

Logon to nVision via Chrome 

 
In this topic you will learn how to Logon to nVision via Chrome. 

 

 

Step Action 

1. nVision is an Excel-based add-on application for PeopleSoft Financials that allows 

the user to report on transactional data. Once a user processes a report, because 

the output is in a spreadsheet format, the user may then manipulate the data using 

Excel functionality. 

 

 

 
 

Step Action 

2. Double-click the PS Launcher button. 
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Step Action 

3. From the PS Launcher panel, you will select the following: 

 

PeopleSoft System: Financials 

Database: PS 9.2 Financials Reports (PS9FSRPT) 

Application: PeopleSoft 

4. Click the button to the right of the Database field. 

 

5. Click the PS 9.2 Financials Reports (PS9FSRPT) list item. 

 

6. Click the Start button. 

 

7. A warning message displays stating you are accessing a non-production database 

and asking if you wish to continue. 

 

Click the Yes button. 

 

8. NOTE: For training purposes only, you will use the User ID and Password 

provided in this exercise. For non-training purposes when entering the Reports 

database, use your User ID and Password for authentication. 
 

Enter the desired information into the User ID field. Enter "KOCONN". 

9. Enter the desired information into the Password field. Enter "LSUtigers". 

10. Click the Sign In button. 

 

11. The My Financials Home page displays, which is your landing page for the Reports 

database. 

12. This completes Logon to nVision. 

End of Procedure. 
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Navigate to nVision Reports via NavBar 

 
In this topic you will learn how to Navigate to nVision Reports via NavBar. 

 
 

Step Action 

1. The NavBar offers users an alternate method of navigating to nVision Reports 

within PeopleSoft. 

 

Click the NavBar button. 

 

2. Click the Menu button. 

 

3. Click the Down button of the scrollbar. 

 

4. Click the Reporting Tools menu. 
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Step Action 

5. Click the PS/nVision menu. 

 

6. Click the PS/nVision Schedule Requests button. 

 

 

 
 

Step Action 

7. The Report Request page displays. When working in Reports, enter your Business 

Unit (BU): HCSDA, LSUNO, or LSUSH. This allows you to search for all nVision 

Reports associated with the specified BU. 

 

Enter the desired information into the Business Unit: field. Enter "LSUSH". 

8. Click the Search button. 

 

9. A list of the nVision reports associated with the specified Business Unit displays. 

10. This completes Navigate to nVision Reports via NavBar. 

End of Procedure. 
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Processing nVision Reports (Excludes Prompts) 

Process Basic Reports - Web Method 

 
In this topic you will learn how to Process Basic Reports - Web Method. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - HCSDA 

 

Report ID - CREX111 - Cash Receipts & Exp - Fund 111 

    LSUNO - TBPERIOD - Trial Balance by Period 

    LSUSH - TBPERIOD - Trial Balance by Period 

 

Type - Printer 
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Step Action 

2. From the My Financials Home landing page, users will navigate to the LSU 

Health Reporting homepage. 

 

Click the button to the right of the My Financials Home field. 

 

3. The LSU Health Reporting homepage is where you will access the three reporting 

applications (i.e., Query, nVision, and BI Publisher) used for displaying PeopleSoft 

data visually. Each application presents retrieved data in a different way, from 

simple spreadsheets to formal accounting reports. The exercises in this manual will 

focus on using the nVision Reports application. 

 

Click the LSU Health Reporting link. 

 

4. Click the nVision button. 
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Step Action 

5. When working in Reports, enter your Business Unit (BU): HCSDA, LSUNO, or 

LSUSH. This allows you to search for all nVision Reports associated with the 

specified BU. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "HCSDA". 

6. Click the Search button. 

 

7. The report list displays below the Search button. You are viewing the first 100 out of 

161 reports. 

 

Click the View All link. 

 

8. A list of available reports for HCSDA displays. Scroll to find the CREX111 - Cash 

Receipts & Exp - Fund 111 option. 

 

Click the Down button of the scrollbar. 

 

9. Click the CREX111 link. 
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Step Action 

10. This page is divided into three sections: 

1. The Report Request Section; 

2. The Report Date Section; and 

3. The Output Options Section 

11. The Report Request Section 
 

The top section includes the Business Unit (BU) and the Report ID (name), the 

Report Title (report description), and *Layout (name utilized by Report Request). 

 

To the right are links that allow users to Copy the report request (based on user's 

security), Transfer (navigate) to Report books, navigate to the Process Monitor, 

and navigate to the Report Manager. An additional link allows users to Share 

private report requests with other users (security based). 

12. The Report Date Section 
 

There are four (4) options available for the '*As Of Reporting Date': 

• Business Unit Reporting Date - is the current month - set by GL team when they 

close and update the current month 

• Default - is not recommended for use 

• Specify - can be used to select the end date of a month if current month is not 

updated as yet 

• Today’s Date - is not recommended for use 

 

Balance Sheet Reports will generally use the 'Business Unit Reporting Date.' 

Financial Statement type reports will use end of month or end of year most of the 

time. 

13. The Report Date Section (continued) 
 

The 'Tree As Of Date' has three options from which to select: 

• Default - not recommended for use 

• Specify - can be used to select the end date of a month if current month is not 

updated as yet 

• Use As Of Reporting Date - will use date selected for '*As Of Reporting Date' 

 

Generally, the '*Tree As Of Date' will typically be set to 'Use as of Reporting 

Date.' 

 

A checkbox displays below the 'Tree As of Date' line that reads, "Override Tree 

As of Date if Specified in Layout." This box will always remain checked. 
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Step Action 

14. The Output Options Section 
 

Type: Allows the user to choose the output type of Web, Window, File, Email, or 

Printer. For this example, the output type of Web will be used. The output type of 

Window (most commonly used) will be demonstrated in the next exercise and in the 

example for the Drill feature. Writing the report to a file and sending a report via 

email documentation are included in a later exercise. 

 

The Format will always be Microsoft Excel xls. 

15. Click the Scope and Delivery Templates link. 

 

NOTE: Most often, users will not make any changes to the subpanels found in 

Scope and Delivery Templates. 

 

16. The nVision Web Output subpanel displays. The options shown on this subpanel 

are determined by the Output Options Type (e.g., Web, Window, Email, Printer, or 

File) selected on the Report Request page. The subpanel here displays fields for the 

output type Window or Web. 

 

The BU and Report ID are shown at the top of the page. 

17. • Report Scope – will contain the Scope name if one is used with the report 

    o Scopes are used to create multiple report instances based on a set of parameters. 

• Folder Name – is not used by LSU Health 

• Retention Days – is not used by LSU Health 

18. • Directory Name – used to identify the file location if the File output type is 

selected (e.g., \\PSFILESRVR\LSUMC-

NO.ENT\PEOPLESOFT\NVISIONRPTFILES\REPORTS\XXXX, where XXXX is 

enter as HCSD) 

    o HCSDA is usually the only unit to utilize this feature. However, LSUNO 

VCAF office uses the feature for one set of reports. 

    o Deeper level folders may be added after the XXXX level to further segregate 

the reports. 

    o View completed reports by navigating to 

V:\PeopleSoft\nVisionRPTFiles\Reports\XXXX 

    o Instructions for this type of report processing can be found in the Appendix. 
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Step Action 

19. • Content Delivery Template – also used to identify the file name that will appear 

in the Report Repository 

    o Report Variables are used as values for the template. The most common 

examples are: 

         %RTT% - Report Title 

         %RBU%-%RTT% - Requesting Business Unit – Report Title 

         %RID% - Report ID 

         %SFD%-%RTT% - Scope Field Description – Report Title 

 

• Security Template – will not be used for Web based Report Distribution with the 

repository 

20. If Printer or File is selected as the output type, then the nVision File/Printer 

Output subpanel displays. The BU and Report ID are shown at the top of the 

subpanel. 

21. The Report Scope and Directory Name Template fields were introduced as part of 

the nVision Web Output subpanel, so they will not be reviewed again here. 

22. • File Template – used to identify the file name that will appear in the Report 

Repository 

    o This options will display when the Output Options Type is File, Printer or 

Email. 

    o The File template is used to name the .xls field. 

         For example, if you wanted the Excel file name to include the Report ID and 

the BU is HCSDA, the variable entered into the File Template field will be 

%RID%-%RBU%.xls. This will display in the repository as CREX111-

HCSDA.xls 

 

         For LSUNO and LSUSH using the TBPERIOD report the variable will be: 

            • %RID%-%RBU%.xls which will display as TBPERIOD-LSUNO.xls 

            • %RID%-%RBU%.xls which will display as TBPERIOD-LSUSH.xls 

23. If Email is selected as the output type, then the nVision Email Output subpanel 

displays. The BU and Report ID are shown at the top of the subpanel. 

24. The Report Scope, File Template and Directory Name Template fields were 

introduced for other output subpanels, so they will not be reviewed again here. 

 

• Email Template – used to list email addresses to specify who will receive the 

report 

    o If multiple email addresses are used separate each address with a comma 

25. NOTE: Information on the Advanced Options is pre-set. Please do not use any 

links or change any settings on this tab. 

26. Click the LSU Define Prompt tab. 
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Step Action 

27. The LSU Define Prompt page allows users to enter the prompt values for the 

reports that use run-time prompts. Fields that are bold are required prompt values 

for the report. In this example, the report is a basic one, not using any prompts 

except for BU. Thus, there are no required fields for entry. 

28. Click the nVision Report Request tab. 

 

29. Click the button to the right of the *As Of Reporting Date: field. 

 

30. Click the Specify list item. 

 

31. Enter the desired information into the *As Of Reporting Date field. Enter 

"063023". 

32. Click the button to the right of the *Tree As Of Date: field. 

 

33. Click the Specify list item. 

 

34. Enter the desired information into the *Tree As Of Date field. Enter "063023". 

35. Click the Override Tree As of Date if Specified in Layout option. 

 

NOTE This option should always be checked. 

 

36. Click the button to the right of the Type: field. 

 

37. Click the Web list item. 

 

38. NOTE: Every report request must be saved before running the report. 
 

Click the Save button. 

 

39. Click the Run Report button. 
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Step Action 

40. The Server Name has already been entered. If the Server Name had not been 

entered, you would click the drop-down button to the right of the Server Name field 

to select the PSNT option. All other options will remain as defaulted on this page. 

 

Click the OK button. 

 

41. Click the Process Monitor link. 

 

42. You want the Run Status = Success and the Distribution Status = Posted. In this 

example, these values are already achieved. If your statuses were something other 

than Success and Posted, you would click the Refresh button every 10-15 seconds 

until statuses are achieved. 

 

Click the Report Manager link. 

 

43. Click the Administration tab. 

 

44. This page displays a list of reports for your User ID. The uppermost report in the list 

is the most recent report. To open a report, simply click the report name link in the 

Description column of the page. 

 

NOTE: The information displayed in the Description column is the result of the 

specification in the Content Description Template box on the Report Request 

page. 
 

Click the Cash Receipts & Exp - Fund 111 link for HCSDA users. LSUNO and 

LSUSH users, please select the Trial Balance by Period link. 

 

NOTE: This will open a new window. 

 

45. Your report displays. Some reports may include Macros, so you may receive a 

Security Warning pop-up message. 

 

Click the Enable Content button. 

 

46. Click the Close button. 
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Step Action 

47. Click the Go back to Process Requests link. 

 

48. Click the Go back to Report Request link. 

 

49. You are returned to the nVision Report Request page. 

50. This completes Process Basic Reports - Web Method. 

End of Procedure. 
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Process Basic Reports - Window Method 

 
In this topic you will learn how to Process Basic Reports - Window Method. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - LSUNO 

 

Report ID - BSDETAIL - Balance Sheet Detail Report 

    LSUSH - BSDETAIL - Balance Sheet Detail Report 

    HCSDA - CREX111 - Cash Receipts & Expenditures Report 

 

Type - Printer 

 

 
 

Step Action 

2. Click the button to the right of the My Financials Home field. 
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Step Action 

3. Click the LSU Health Reporting link. 

 

4. Click the nVision button. 

 

 
 

Step Action 

5. When working in Reports, enter your Business Unit: HCSDA, LSUNO, or LSUSH. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "LSUNO". 

6. Click the Search button. 

 

7. A list of available reports for LSUNO displays. Scroll to find the BSDETAIL - 

Balance Sheet Detail Report option. 

 

 

Click the Down button of the scrollbar. 
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Step Action 

8. Click the BSDETAIL link. 

 

9. In this example, the *As Of Reporting Date will be Today's Date. The *Tree As Of 

Date will remain as defaulted. 

 

Click the button to the right of the As Of Reporting Date: field. 

 

10. Click the Today's Date list item. 

 

11. In the Output Options section, the *Type will be Window for this example. The 

*Format will ALWAYS be Microsoft Excel.xls. 

 

Click the button to the right of the Type: field. 

 

12. Click the Window list item. 

 

13. Parameters must be saved prior to running the report. 

 

Click the Save button. 

 

14. Click the Run Report button. 

 

15. All parameters will remain as defaulted on this panel. If the Server Name had not 

defaulted, you could have selected it by clicking the drop-down arrow to the right of 

the field. 

 

Click the OK button. 

 

16. As the report runs, a pop-up window displays. It will show the status of the report as 

it progresses from Queued, to Processing, to Processing Preparing output for 

viewing, or Error. 

17. When the report processes to its conclusion, the pop-up window displays your report 

in Excel. Some reports include Macros, so you may receive a Security Warning pop-

up. 

 

Click the Enable Content button. 
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Step Action 

18. After enabling the Macro content, you are returned to the spreadsheet. The Security 

Warning disappears and the Macros included in the file are enabled. 

19. Click the Close button. 

 

20. Close the processing tab. 

 

Click the Close tab. 

 

21. This completes Process Basic Reports - Window Method. 

End of Procedure. 
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Perform Drilldown 

 
In this topic you will learn how to Perform Drilldown. 

 

 

Step Action 

1. The BSDETAIL report, which was run in the Process Basic Reports - Window 

Method topic , will be used as the example report for the Perform Drilldown topic. 

 

 
 

Step Action 

2. While navigating through the report, it is recommended that users 'Freeze Panes' so 

that the row and column headers remain visible. 

 

Click the E10 cell. 

 

3. Click the View button. 

 

4. Click the button to the right of the Freeze Panes option. 
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Step Action 

5. Click the Freeze Panes list item. 

 

6. In this example, you will drill on the A/P-Travel & Direct Pay row, Current 

Balance column of the report. The selected row must intercept with a column which 

displays a number. The number cannot be the result of an equation such as a sum of 

several rows added together. Equation results cannot be drilled on.  

 

Click the Down button of the scrollbar. 

 

7. Select the A/P-Travel & Direct Pay row, Current Balance column of the report. 

 

Click the E196 - A/P-Travel & Direct Pay - Current Balance cell. 

 

8. Click the Add-ins tab. 

 

9. Click the button to the right of the nVisionDrill field. 

 

10. Click the Drill menu. 

 

11. A new window opens displaying the various drills that are available for use. Simply 

select the Run Drilldown button to the right of the desired drill option. In this 

example, select the Breakdown by Account and Department drill. 

 

NOTE: The *Type: selection box at the top left of the page displays Window. This 

allows the drill to run to the output option of Window. For drills, Window is the 

default option. The other option is Web, which would run the drill report and post 

it to the report repository. 

12. Click the Breakdown by Account and Dept - Run Drilldown button. 

 

13. When the report is run with the output type of Window, the nVision drill menu is 

replaced by the Status Window. Once completed, the status of 'Success Preparing 

output for viewing' displays in the window. At the same time, a new Excel 

spreadsheet window is created that will display the drill results. 
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Step Action 

14. The drill opens in a new window. 

 

You may print the spreadsheet, perform any Excel function, or even perform an 

additional drill. Once you are finished with the drill file, you may close the window. 

 

Click the Close button. 

 

15. Drill files can be saved if needed. In this example, you will not save the drill file. 

 

Click the Don't Save button. 

 

16. You are returned to the original nVision report file where you may perform 

additional drills if desired. 

 

In this example, you will run a second drill on the A/P -Manual-Non-Open Item 

row cell in the Previous Month Balance column. The drill option you will use is 

Journal Drill. 

17. Click the G204 - A/P-Manual-Non-Open Item - Previous Balance cell. 

 

18. Click the button to the right of the nVisionDrill field. 

 

19. Click the Drill menu. 

 

20. Click the Journal Drill - Run Drilldown button. 

 

21. When a report is run in the output type of Window, the nVision drill menu is 

replaced by the Status Window. Once completed, the status of 'Success Preparing 

output for viewing' displays in the window. At the same time, a new Excel window 

is created that will display the drill results. 

22. The drill report opens in a new window. 

 

In many instances, users will want to filter the drill results to limit the data by a 

specific department, fund, period, or other criterion. Auto Filter is used to perform 

this task. 

 

Click the Data tab. 
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Step Action 

23. Click the Filter button. 

 

24. NOTE: Each column heading is now populated with a drop-down button. 
 

Click the button to the right of the Fund field. 

 

25. De-select the Select All option. 

 

Click the (Select All) option. 

 

26. Click the 911 option. 

 

27. Click the OK button. 

 

28. The spreadsheet now displays only those items charged to Fund 911. Once you have 

finished with the drill file, you may close it. 

 

Click the Close button. 

 

29. Drill files may be saved. However, for this example you will select 'Don't Save'. 

 

Click the Don't Save button. 

 

30. You are returned to the original report. No further drills will be performed, so you 

may close the report. 

 

Click the Close button. 

 

31. Click the Don't Save button. 

 

32. Close the drill window. 

 

Click the Close Drill Down Window tab. 
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Step Action 

33. Close the first drill down window. 

 

Click the Close Drill Down tab. 

 

34. Click the Go back to Report Request link. 

 

35. You are returned to the nVision Report Request page. 

36. This completes Perform Drilldown. 

End of Procedure. 
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Process Reports - Output Type PRINTER 

 
In this topic you will learn how to Process Reports - Output Type Printer. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - LSUSH 

 

NOTE: All BUs will use the same Report ID for this exercise. 
 

Report ID - TBDETAIL - Trial Balance - Detail 

 

Type - Printer 

 

 
 

Step Action 

2. Click the nVision button. 

3. When working in Reports, enter your Business Unit: HCSDA, LSUNO, or LSUSH. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "LSUSH". 
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Step Action 

4. Click the Search button. 

 

5. A list of available reports for LSUSH displays. Scroll to find the TBDETAIL - 

Trial Balance - Detail option. 

 

Click the View All link. 

 

6. Click the Down button of the scrollbar. 

 

7. Click the TBDETAIL link. 

 

8. Click the button to the right of the *Tree As Of Date: field. 

 

9. Click the Use As Of Reporting Date list item. 

 

10. Click the button to the right of the *Type: field. 

 

11. Click the Printer list item. 

 

12. Click the Save button. 

 

13. Click the Run Report button. 

 

14. On the Process Scheduler Request page, you must select the *Type as Printer. 

 

Click the button to the right of the *Type field. 

 

15. Click the Printer list item. 

 

16. Once the *Type is changed to 'Printer', the *Format options changes to 'XLS' and 

the Output Destination field displays. 
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Step Action 

17. NOTE: In the Output Destination box, enter the network printer to which the 

report will be sent. If you are unsure of the which network printer to send the 

report, contact your local PC supporter. 
 

For training purposes only, enter the desired information into the Output 

Destination field. Enter "\\lafprnsrv\LANIER". 

18. The user would then click the OK button to return to the Report Request page. The 

report would process and then be sent to the selected printer. 

 

For training purposes only, click the Cancel button. 

 

19. This completes Process Reports - Output Type Printer. 

End of Procedure. 
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Process Reports - Output Type EMAIL 

 
In this topic you will learn how to Process Reports - Output Type Email. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - LSUNO 

 

Report ID - TBFUND - Trial Balance by Fund 

    LSUSH - TBFUND - Trial Balance by Fund 

    HCSDA - TBALLFND 

 

Type - Email 

 

 
 

Step Action 

2. Click the nVision button. 
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Step Action 

3. When working in Reports, enter your Business Unit: HCSDA, LSUNO or LSUSH. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "LSUNO". 

4. Click the Search button. 

 

5. A list of available reports for LSUNO displays. Scroll to find the CREX111 - Cash 

Receipts & Exp - Fund 111 option. 

 

Click the View All link. 

 

6. Click the Down button of the scrollbar. 

 

7. Click the TBFUND link. 
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Step Action 

8. Users will leave the '*As Of Reporting Date:' and the '*Tree As Of Date:' as 

defaulted. 

 

Click the Type: list. 

 

9. Click the Email list item. 

 

10. Click in the Scope and Delivery Templates field. 

 

11. On the nVision Email Output page, enter the recipient's email address in the Email 

Template field. Multiple user email addresses can be entered, but must be separated 

by a colon and a space (e.g., xxxx@lsuhsc.edu; xxxx@lsuhsc.edu). 

 

Enter the desired information into the Email Template: field. Enter 

"koconn@lsuhsc.edu". 

12. Click the OK button. 

 

13. Click the Save button. 

 

14. Click the Run Report button. 

 

15. All fields will remain as defaulted. 

 

Click the OK button. 

 

16. Click the Process Monitor link. 

 

17. Click the Process Monitor. 

 

18. Click the Refresh button every 10 - 15 seconds until the Distribution Status = 

Posted. 

 

Click the Refresh button. 
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Step Action 

19. Once the Distribution Status = Posted, the system will generate and send an email 

to the listed email account with the report attached. 

 

NOTE: The email will be sent from PS9FSRPT@lsuhsc.edu. 

20. Click the Outlook button. 

 

21. Click the TBFUND.xlsx button. 

 

22. The TBFUND report displays. 

23. Click the Minimize Outlook button. 

 

24. Click in the Go back to Report Request field. 

 

25. This completes Process Reports - Output Type Email. 

End of Procedure. 
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Process Reports - Output Type EMAIL - Preferred Method (May enter 
text in body of email) 

 
In this topic you will learn how to Process Reports - Output Type Email - Preferred Method 

(May enter text in body of email. 

 

 

Step Action 

1. For this exercise, the same Report Request used for the previous topic will be used 

to complete this exercise. 

 

BU - LSUNO 

 

Report - TBFUND - Trial Balance by Fund 

    LSUSH - TBFUND - Trial Balanace by Fund 

    HCSDA - TBALLFND - Trial Balance by Fund by BU 

 

*Type - Web 
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Step Action 

2. Click the button to the right of the *Type: field. 

 

3. Click the Web list item. 

 

4. NOTE: All other parameters will remain as defaulted. 
 

Click the Save button. 

 

5. Click the Run Report button. 

 

6. Click the button to the right of the *Type field. 

 

7. On the Process Scheduler Request page, *Type must be changed from 'Default' to 

'Email'. 

 

Click the Email list item. 
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Step Action 

8. NOTE: *Format automatically changes to XLS and Distribution link displays. 
 

Click the Distribution link. 

 

9. Enter the desired information into the Email Subject field. Enter "TBFUND 

Training Example". 

10. Enter the desired information into the Message Text field. Enter "Please review 

and get back with me". 

11. NOTE: Multiple user email addresses can be entered, but must be separated by a 

colon and a space (e.g., xxxx@lsuhsc.edu; xxxx@lsuhsc.edu). 
 

Enter the desired information into the Email Address List field. Enter 

"koconn@lsuhsc.edu". 

12. Click the Down button of the scrollbar. 

 

13. NOTE: The email feature is a great tool. However, it does not allow the sender to 

preview the report output before sending the report to the recipient. 
 

Click the OK button. 

 

14. Click the OK button. 

 

15. Click the Process Monitor link. 

 

16. Click the Right button of the scrollbar. 

 

17. Click the Refresh button every 10 - 15 seconds until the Distribution Status = 

Posted. 

 

Click the Refresh button. 

 

18. NOTE: The system delivers an email to the specified users once the Distribution 

Status = Posted. 
 

Click the Process Monitor. 
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Step Action 

19. Click the Go back to Report Request link. 

 

 

 
 

Step Action 

20. Click the Outlook button. 
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Step Action 

21. Click the TBFUND.xlsx button. 

 

22. Close the spreadsheet after review. 

 

Click the Close button. 

 

23. Click the Minimize Outlook button. 

 

24. This completes Process Reports - Output Type Email - Preferred Method (May 

enter text in body of email). 

End of Procedure. 
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Processing nVision Reports (Includes Prompts) 

Process Prompt Reports 

Procedure 

 
In this topic you will learn how to Process Prompt Reports. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - HCSDA 

 

Report ID - WTBSFND - Trial Balance - Single Fund 

    LSUNO - WAJ_PROJ - Project to Date Activity - NO 

    LSUSH - WSHRPROJ - Project to Date Activity Shrev 

 

Type - Window 

 

 
 

Step Action 

2. Click the nVision button. 
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Step Action 

3. When working in Reports, enter your Business Unit: HCSDA, LSUNO or LSUSH. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "HCSDA". 

4. NOTE: The Report Requests for reports that include prompts all begin with the 

letter "W".  
 

Enter the desired information into the Report ID field. Enter "W". 

5. Click the Search button. 

 

6. A list of available Report Requests for the specified BU display. Scroll through the 

list to select the WTBSGFND report. 

 

Click the Down button of the scrollbar. 

 

7. Click the WTBSGFND link. 

 

8. Enter the desired information into the *As Of Reporting Date field. Enter 

"073123". 

9. Click the Save button. 

 

10. Click the LSU Define Prompt tab. 

 

11. This page is used to enter the prompt values desired to run the report. Each of the 

fields that appear in bold print are required for that particular report (e.g., *Business 

Unit and *FUND CODE). The fields that appear as grey fields are not used or 

changeable for the specified report 

12. The *Business Unit (BU) is required for every report as it defaults from the Report 

Request page. The BU may be overwritten on the LSU Define Prompts page to 

request data for a different BU. 

 

NOTE: Row security exists and you will only be able to retrieve results for the BU 

for which you have access. 

13. When required in a Report Request, the chartfield values may accept wildcard's or 

partial wildcard's. The wildcard is the '%'. The date fields generally must be entered 

in full. 
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Step Action 

14. In this example, the Business Unit and Fund Code are in bold text, thus these are 

the only fields requiring data. No changes are needed to the Business Unit. 

 

Enter the desired information into the *FUND CODE field. Enter "111". 

15. Click the Save button. 

 

16. Click the nVision Report Request tab. 

 

17. Click the Run Report button. 

 

18. All parameters will remain as defaulted. 

 

NOTE: After clicking the OK button and returning to the Report Request page, 

the nVision Processing Window will display. 
 

Click the OK button. 

 

19. The new window opens showing a status of Queued. Simply wait for the process to 

complete. You do not need to do anything to further the process. 

20. Once the Status changes to Success, the Excel file will open in a new window. 

21. You may print, save or perform drilldowns on this report. Once you complete your 

review, close the report. 

 

Click the Close button. 

 

22. Click the Close Process Window button. 

 

23. This completes Process Prompt Reports.  

End of Procedure. 
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Process Multiple Prompts and Partial Wildcard Reports 

 
In this topic you will Process Multiple Prompt and Partial Wildcard Reports. 

 

 

Step Action 

1. In this example, the following parameters will be used: 

 

BU - LSUSH 

 

Report ID - WAPDETAIL - AP Detail Shreveport 

    HCSDA - WSHRPROJ - Project to Date Activity Shrev 

    LSUNO - W_APDET - AP Detail for New Orleans 

 

Type - Web 

 

 
 

Step Action 

2. Click the button to the right of the My Financials Home field. 
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Step Action 

3. Click the LSU Health Reporting menu. 

 

4. Click the nVision button. 

 

 
 

Step Action 

5. When working in Reports, enter your Business Unit: HCSDA, LSUNO or LSUSH. 

 

For training purposes only, enter the desired information into the Business 

Unit: field. Enter "LSUSH". 

6. NOTE: The Report Requests for reports that include prompts all begin with the 

letter "W".  
 

Enter the desired information into the Report ID: field. Enter "W". 

7. Click the Search button. 
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Step Action 

8. A list of available Report Requests for the specified BU display. Scroll through the 

list to select the WAPDETAIL report. 

 

Click in the WAPDETAL field. 

 

9. All parameters on the nVision Report Request tab will remain as defaulted. The 

report will run to Web output and be retrieved on the Report Manager page. 

 

Click the LSU Define Prompt tab. 

 

10. For this report, the *Business Unit, *FUND CODE, *PROGRAM CODE, 

%DEPTID, *PROJECT ID, *CLASS FIELD, *BEGIN DATE, and *END DATE 

are required. 

 

The *Business Unit may be changed, but will remain as defaulted for this exercise. 

You will enter information for the *FUND CODE, *DEPTID, and *BEGIN 

DATE.  

 

Wildcards (%) will remain as defaulted for the *PROGRAM CODE, *CLASS 

FIELD, and *PROJECT ID. The *END DATE will also remain as defaulted. 

11. The following parameters will be entered: 

 

*FUND CODE - 113 

*DEPTID - 149% 

*Begin Date - 07/01/23 

12. Enter the desired information into the *FUND CODE field. Enter "113". 

13. Enter the desired information into the *DEPTID field. Enter "149%". 

14. Enter the desired information into the *BEGIN DATE field. Enter "070123". 

15. Click the Save button. 

 

16. Click the nVision Report Request tab. 

 

17. Click the Run Report button. 

 

18. All parameters will remain as defaulted on this page. 

 

Click the OK button. 
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Step Action 

19. Instead of proceeding to the Process Monitor page, as an alternative, navigate 

directly to the Report Manager. 

 

Click in the Report Manager field. 

 

20. The Report Manager page displays and you are defaulted into the Administration 

tab. 

 

Click the Right button of the scrollbar. 

 

21. You want the Status = Posted. Click the Refresh button every 15- 20 seconds to 

update the Status. 

 

NOTE: The APDETAIL report is known to take a long time to run and will not 

display in the Description column list right away. 
 

Click the Refresh button. 

 

22. Once the report Status = Posted, click the AP Detail Shreveport link in the 

Description column. 

 

Click the AP Detail Shreveport link. 

 

23. The report displays and may be printed, copied, saved, etc. After completing review, 

close the report window. 

 

NOTE: This report produces a listing of data and drilldown may not be performed 

on this report. 
 

Click the Close button. 

 

24. Click the Left button of the scrollbar. 

 

25. Click the Go back to Report Request link. 

 

26. This completes Process Multiple Prompts and Partial Wildcard Reports. 

End of Procedure. 
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Appendix 

Enable Drilldown Feature 

 
In this topic you will learn how to Enable the Drilldown Feature. 

 
 

Step Action 

1. Click the nVision button. 

2. Click the Report Manager menu. 

 

3. Click the Cash Receipts & Exp - Fund 111 link. 

 

4. Click the Enable Content button. 

 

5. The Drilldown feature must be enabled the first time you use it. Once enabled, an 

Add-Ins option will be added next to the View option on your ribbon. 

 

Click the File Tab button. 

 



Training Guide 
 

All Sites 
 

 Page 48 

Step Action 

6. Click the Options menu. 

 

7. Click the Add-ins list item. 

 

8. Click in the DrillToPIA field. 

 

9. Click the Go... button. 

 

10. A small pop-up box displays. If the DrillToPIA option is not already checked, then 

click the checkbox to select it. 

 

Click the OK button. 

 

11. the Add-Ins option displays in your ribbon. 

 

Click the Add-ins tab. 

 

12. The nVisionDrill option displays. This setting will now be retained from session to 

session. 

 

Click the button to the right of the nVisionDrill field. 

 

13. In this example, you would click the Drill option to drilldown on Current Period 

Activity for Office Supplies amount. 

14. This completes Enable Drilldown Feature. 

End of Procedure. 
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Procedure for Enabling Macros 

 
In this topic you will learn the Procedure for Enabling Macros. 

 

 

Step Action 

1. Users may choose to enable all macros for Excel/nVision, thus allowing all of the 

custom macros in the nVision reports to run as desired. The user must enable all 

macros through the Trust Center in Excel Options. Once selected, this setting is 

retained in the PSDesktop session to session. If a user chooses not to enable all 

macros, the user would need to enable macros for each file containing macros. 

 

 
 

Step Action 

2. Click the File Tab button. 

 

3. Click the Options menu. 
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Step Action 

4. Click the Trust Center list item. 

 

5. Click the Trust Center Settings... button. 

 

6. Click the Macro Settings menu. 

 

7. Click the Enable all macros (not recommended; potentially dangerous code can 

run) option. 

 

8. Click the OK button. 

 

9. Click the OK button. 

 

10. This completes Procedure for Enabling Macros. 

End of Procedure. 
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Process Reports - Output type FILE (HCSD only) 

 
In this topic you will learn how to Process Reports - Output Type FILE (HCSD and LSUNO 

VCAF only). 

 

 

Step Action 

1. the following parameters will be used for this exercise on the nVision Report 

Request page: 

 

*Business Unit - HCSDA 

 

*Report ID - CREX111 

 

*As Of Reporting Date - Today's Date 

 

*Type - File 

 

 
 

Step Action 

2. Click the nVision button. 
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Step Action 

3. NOTE: The HCSDA Business Unit is the only other BU that may use the File 

option. 
 

Enter the desired information into the Business Unit: field. Enter "HCSDA". 

4. Click the Search button. 

 

5. Click the Down button of the scrollbar. 

 

6. Click the CREX111 - Cash Receipts & Exp - Fund 111 link. 

 

7. Click the button to the right of the *As Of Reporting Date: field. 

 

8. Click the Today's Date list item. 

 

9. Click the button to the right of the *Tree As Of Date: field. 
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Step Action 

10. Click the Use As Of Reporting Date list item. 

 

11. Click the button to the right of the *Type: field. 

 

12. Click the File list item. 

 

13. Click the Scope and Delivery Templates link. 

 

14. The end location for the report must be entered in the Directory Name Template 

field. You may not run the reports to a user's C:\ or O:\. If that is the desired end 

location, first run the report and then cut and paste the file to the folder. 

 

The Directory Name Template you will enter is: 

 

\\PSFILESRVR\LSUMC-

NO.ENT\PEOPLESOFT\NVISIONRPTFiles\REPORTS\XXXXX\ 
 

where 'XXXX' is replaced with  HCSD. Additionally, the user may enter deeper 

level folders to further identify their reports. 

 

Enter the desired information into the Directory Name Template: field. Enter 

"\\PSFILESRVR\LSUMC-

NO.ENT\PEOPLESOFT\NVISIONRPTFiles\REPORTS\HCSDA\". 

15. Click the OK button. 

 

16. Click the Save button. 

 

17. Click the Run Report button. 

 

18. All parameters will remain as defaulted. 

 

Click the OK button. 

 

19. Click in the Process Monitor field. 
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Step Action 

20. Click the Right button of the scrollbar. 

 

21. The new report displays at the top pf the list on the Process Monitor page. Click the 

Refresh button every 10 - 15 seconds until the Run Status = Success and the 

Distribution Status = Posted. 

 

Click the Refresh button. 

 

22. Click the Left button of the scrollbar. 

 

23. Click in the Go back to Report Request field. 

 

24. To view the report, open Excel or Windows Explorer and navigate to to the folder 

address below to locate the file: 

 

V:\PeopleSoft\nVisionRptFiles\Reports\HCSDA\ 

25. This completes Process Reports - Output Type File (HCSDA and LSUNO VCAF 

only). 

End of Procedure. 

 

 


